Don't know where to start? Read these tutorials:

**How to remove trial restrictions**
Save your video without a watermark and use the program after 14 days.

**Make a video from scratch**
Learn how to do basic editing using the Timeline.

**Record a video or a screencast**
Set your software and hardware for a seamless recording.

More questions?
Write us an e-mail at support@movavi.com
Table of contents

Activating Movavi Academic ......................................................... 3
Activating without Internet access ............................................... 4
Managing subscription .................................................................. 6
Creating video ............................................................................ 6
Quick start .................................................................................. 7
Creating a quick video .................................................................. 8
Adding media ............................................................................... 11
Searching photos online ............................................................ 12
Creating an intro .......................................................................... 12
Managing projects ....................................................................... 12
Transferring projects ................................................................... 14
Appending projects ...................................................................... 14
Project settings ............................................................................ 15
Preview and organize clips ............................................................ 16
  Timeline tracks ........................................................................... 18
Hiding and muting clips ............................................................... 20
Undo actions ................................................................................ 21
Cutting clips ................................................................................ 21
Edit and enhance clips ................................................................. 23
  Rotating videos and images ......................................................... 24
  Cropping .................................................................................... 25
  Color adjustments ...................................................................... 26
  Video speed .............................................................................. 27
  Reversing video ........................................................................ 28
  Image duration .......................................................................... 29
  Fading video ............................................................................ 30
  Creating overlays ....................................................................... 31
  Adding a watermark ................................................................... 32
  Creating a freeze frame ............................................................. 34
  Removing black bars .................................................................. 35
  Fading effects ........................................................................... 36
Editing audio ................................................................................ 37
  Removing audio ........................................................................ 38
  Extracting audio from videos ................................................... 39
  Looping audio .......................................................................... 40
  Volume curves .......................................................................... 40
  Linking audio ........................................................................... 41
  Fading audio ............................................................................ 41
  Equalizer .................................................................................. 42
  Noise removal ........................................................................... 42
  Audio effects ............................................................................ 43
  Beat detection ............................................................................ 44
Filters .......................................................................................... 45
Quiz ............................................................................................. 46
Transitions .................................................................................. 47
Titles ............................................................................................ 48
Timer ............................................................................................ 49
Stickers ....................................................................................... 50
Callouts ....................................................................................... 51
Animation .................................................................................... 52
Pan and zoom .............................................................................. 53
Stabilizing video .......................................................................... 56
Highlight and conceal ................................................................. 57
Chroma key .................................................................................. 58
Exporting videos .......................................................................... 60
  Exporting quiz .......................................................................... 62
  Export only audio ...................................................................... 63
  Export for devices ...................................................................... 65
  Export for TVs .......................................................................... 66
  Uploading online ....................................................................... 67
Video Editor preferences ............................................................... 70
  General preferences .................................................................. 71
  File preferences ......................................................................... 72
  Sharing preferences ................................................................. 73
  Acceleration preferences .......................................................... 73
Record computer screen ............................................................... 74
Control panel ............................................................................... 75
Recording video from screen ...................................................... 75
Record audio only ........................................................................ 77
Mouse cursor effects .................................................................... 78
Recording keystrokes ................................................................... 80
Scheduling ................................................................................... 81
Time limit ..................................................................................... 82
Taking screenshots ....................................................................... 83
Screen recorder preferences ....................................................... 84
  General preferences ................................................................. 84
  File preferences ......................................................................... 86
Activating Movavi Academic

When you first start Movavi Academic, it will be running in TRIAL MODE. To use the program without the trial restrictions, you will need to buy the full version and activate Movavi Academic. If you don't have the activation key yet, click the button below to visit the site and purchase the key.

1. Launch the program.
2. Click the **key** icon in the upper left corner.
3. Copy the key from the email you received and paste it in the new window.
4. Click **Activate**.

You can also activate the software form the program's menu:
1. Go to the **Help** menu and select **Activate Software**.
2. Copy the activation key from your e-mail and paste it in the activation window.
3. Click **Activate**.

Activating without Internet access
If the computer you have installed Movavi Academic on is not connected to the Internet, you can activate the program via e-mail.
I bought Movavi Academic, but my videos already have a watermark. After you have activated the program, you can open the movie project and re-export the movie without the watermark.

### Activating without Internet access

If you don't have Internet access, you can activate the program remotely. If you still don't have an activation key, click the button below to buy the key. After the purchase is completed, the key will be delivered to you via email. If you already have the key, skip to the next step.

1. Launch the program.
2. Click the **key** icon in the upper left corner.

![Click to activate](image1.png)

3. Enter your activation key and select the **Activate offline** option. Click **Activate**.

![Enter the key](image2.png)

4. In the next window, click **Copy** and transfer this information to a computer or device with an Internet connection.
5. When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should receive a reply within an hour. Copy the activation key from the reply and transfer it to the computer with Movavi Academic.

6. Return to the window with offline activation. If you’ve closed the window, repeat the steps 1-3 and enter the same activation key you used before. Then, paste the registration key into the box and click Activate.

If the activation is not happening
• Make sure that you have used a correct activation key. There should not be any additional symbols or spaces after the last digit of the key.
• Also make sure that the key you're using is meant for the Movavi Academic.
- Before attempting the activation, stop the antivirus software and the firewall of the computer.
- Check that your user account has the administrator rights.
- If nothing helps, e-mail the support team.

**Managing subscription**
If your subscription has expired, you need to renew it to continue using the program.

To renew your subscription, click the **Renew Subscription** button. A web page will open, where you can choose a type of license that you need. Once you've made a purchase and received the activation key in an e-mail, copy the key and paste it into the program window. Then click **Activate**.

**Have troubles renewing the subscription?**
- If you haven't received an e-mail with the activation key within an hour, check the Spam folder in your e-mail box.
- **Contact our support team**, Our experts will help you figure out and solve any of the related problems.

**Creating video**
Create or edit videos on any topic using such instruments as chroma key, pan and zoom, stabilization, animation, intros, transitions, effects, titles, stickers and callouts.

To start creating videos
Click **Create Video** in the launch window.
Quick start

Follow this guide to learn about the features of the video editor and to get started quickly.

1. In the File menu select Create New Project.

2. Add media files that will make up the video. Click Add Files or drag and drop your files over the import area.

3. Change the clip layout on the Timeline, crop images, cut videos, using the toolbar.

4. Add effects, transitions, titles, and more by changing the tabs on the left-hand side of the screen.
5. To add items to the project, drag them to the Timeline.

6. Save your video:
   1) Click the Export button.
   2) Choose file format.
   3) Name the video, select a folder to save the video to and set the quality.
   4) Click Start and wait until the processing is finished.

Tip: Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.

Creating a quick video

You can use the Montage Wizard to automatically build a video for you in minutes. All you need to do is provide the Wizard with some video clips or photos, choose a music track, and let the Wizard cut and build the video for you. You can also use the Montage Wizard to make slideshows.

1. Click Quick Video to open the Wizard.
2. On the Files tab, click or drag and drop your files over the window. To remove files, click the \x26; in the upper right-hand corner of each file, or select the files you want to delete and click Delete Selected on the bottom panel.

3. Switch to the Templates tab or click Next.

4. Choose a theme or a transition template. 
   - No transitions template does not add any transitions to your video, but your pictures will still have a Pan and Zoom effect applied by default.
   - Transitions template puts some kind of smooth transitions between the slides.
   - Theme template uses the sample music tracks, a set of different transitions for each of the themes and various title styles.

5. Switch to the Music tab or click Next.

6. Add music. Choose from the built-in tracks* or add music of your own. You can also add more than one track.

   *The audio tracks are royalty-free so you can upload these videos to YouTube and other services.

7. Switch to the Preview tab or click Next.

8. Customize the opening and ending titles, change text and click Apply.
9. Under the Advanced tab make other necessary changes.

- **Video duration**
  You can set your video to be the same length as the audio by selecting the Fit to music length option or use the slider to set how long you want the video to be. If you opt for a shorter video, some clips may not appear in the end result.

- **Fill black bars**
  If the resolution of the project and the files you've added to the video are different, black bars will appear. You can remove them by checking the Fit to frame option – the image resolution will be automatically fitted to the frame size.

10. Watch the finished video in the player on the Preview tab and switch to the Export tab.

11. Select what you want to do next with your video:

- **Save the video** – save the video to your disk.
- **Continue editing** – add final touches to your video by adding effects, more titles, animation and more.
- **Upload online** – save the video to your disk and upload it to YouTube, Vimeo, Google Drive or Movavi Cloud.

12. To save the video, choose a video format and pick a folder to save the video file.

  If you're uploading the video online, sign in with your account and fill in the details about your video. Then click **Start** to begin saving the video.

*Tip: You can also set a desired order of appearance of your files by returning to the Files tab and dragging the file icons in a desired order.*
To save the video, choose a video format you want to use and pick a folder to save the video file. If you're uploading the video online, sign in with your account and fill in the details about your video. Then, click **Start** to begin saving your video file.

Learn more:  
[Exporting videos](#)  
[Uploading to YouTube](#)

**Adding media**

To begin working on your video project, you first need to add some media files. Use your own files or any of the built-in media.

![Image of file import interface](#)

**Add your files**

1. On the **File import** tab click **Add Files**.
2. Select the files and click **Open**. They will appear on the **Media bin** tab.
3. From the **Media Bin** tab drag and drop the files onto the Timeline. You can remove the selection of all files by clicking on an empty space within the bin area, or by selecting a single file.

**Add built-in media**

1. On the **Import** tab select the type of media you want: **sounds**, **music**, **sample video** or **backgrounds**.
2. Switch to a tab
3. Click the file icon to download and see it or to listen to it.
4. Choose a media file and drag it onto the Timeline to add to the project.

![Image of built-in media](#)

**Arrange the files**

Once you've added the files, they will appear on the **Timeline** at the bottom of the window. The Timeline allows you to arrange the clips in the order you want. To reorder the clips, select the clips you want to move and drag them to the new position.

![Image of Timeline](#)

Learn more:  
[Editing video](#)  
[Editing audio](#)
Searching photos online

With Movavi Academic you can search and add images to your video projects without leaving the program and browsing them online. Instead, open the Photo library tab. Within the Search box, type what kind of images you’re looking for and press Enter. Once the search results are shown, you can look through the images and add them to the project.

Adding image to the project
1. Click an image to download it and to see it in a bigger size.
2. Drag the image onto the Timeline, as you would add any other media.

Creating an intro

Intro videos are specifically designed short video clips that use visual elements and text and can be edited or customized. If you don’t know where to start in making a unique intro, you can use the ones that are already made and pre-installed into the program. You will only need to change the text.

Create a new intro
1. In the Titles collection go to Intro videos.
2. Find the New intro clip and drag and drop it onto the Timeline.

Edit the intro
1. Click 📢 on the clip and the Timeline will switch to the intro editing mode.
2. Add your own media files (video, audio or pictures), effects, titles and other. Work as if you’re working with a usual project, but keep in mind that your making a special introductory video.
*Before you start editing, delete the instruction clip that the new intro contains.

Save changes
Click 📜 on the toolbar to save changes and go back to the main editing mode.
To save the intro and use it in other projects, select the intro clip and click 📜. The intro will be saved with all the other items in the collection.
You can edit the intro at any time while working on the project.

Managing projects

A project keeps all the work on your video. You can save the project to finish your work later, or restore your work if you need to edit something after you’ve finished. A new project is created automatically when you start working on a video.

Creating a new project
1. On launching the video editor you can start making a video right away.
2. To start a new project while working on another project, go to the **File** menu and select **Create New Project** or **Create Quick Video**.

**Saving projects**
1. Go to the **File** menu and select **Save Project**. Or use a keyboard shortcut Ctrl+S.
2. Name your project. All projects are stored in the "My Videos\Movavi Academic\Projects" folder of your user.
3. Click **Save**.

You can later open the project file and continue working on it. To avoid losing your editing progress, make sure to save your project every once in a while.

After that, you can save your project as a file in the *.mepx* format on your computer and open it later to continue editing your movie.

**Viewing videos**
Project files cannot be viewed in a regular video player, and can only be opened with Movavi Academic. To view the final video in a player, you need to first export your project to a common video format.

[Learn how to export your project](#)

**Opening projects**
1. Open the **File** menu and select **Open Project**.
2. Find the project file, select it and click **Open**.

You can also open projects in several different ways:
A. Find your project in Windows Explorer and drag it onto the video editor window or double-click it.
B. In the **Import** area click **Add Files** and select find your project.

**Restoring a project from an autosave**
If your computer malfunctions and you cannot save the project, some of your work may be restored using an **autosave** file. Rename the "autosave.mepx" file and open it in the video editor to continue working on your project.

**Restoring media files**
When you open a recent project, you may see a message saying that a file is missing from the project. This may happen if one of the files used in the project has been moved somewhere else or deleted from disk. In this case, click **Specify Folder** in the message box to find the files in their new location, or click **Skip** to open the project without the missing files. You can also click the magnifying glass icon and specify location of a single file. We recommend to copy all the files to your hard drive before editing.
Transferring projects

**Saving portable project**

A portable project is a kind of project that contains all the media files that comprise it. Since the program does not create copies of the files and only refers to their location on the disk, the project will only work properly on another computer if all the media files are present there as well. With the portable project saving option, you don’t have to collect all the files manually.

1. Open the **File** menu and choose **Save Portable Project**
2. Set a path for your project folder to be saved to and click **Save**.
3. Then transfer the project folder to another computer with Movavi Academic installed.

---

Appending projects

If you work on a big project, you might want to separate it into several smaller ones for a more convenient editing process. Then, to combine them back together, append other projects to the major one.

1. Open a project or create a new one.
2. Open the **File** menu and click **Append Project**.
3. In a new window, find and open the project you want to combine with your current project. The project you append will be added at the end of all other clips in the current project.
Project settings

Adjust the parameters of your video, such as bitrate, video resolution and frame rate. These settings affect the quality and the size of a final file. You can change them when saving your video or at any other time.

Opening project settings

In the Export window click the Advanced button.

Video settings

The video settings apply to all videos and photos used in the project. When you import the media files, they will be scaled to fit inside the selected frame size according to your settings.

Codec

Codec is a program that encodes and decodes data. Codecs, as well as bitrate, use data compression and affect the size of a final media file, so it is easier to store and manage the file.

Resolution

The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the resolution of the videos and photos you plan to use in your project, and should not exceed the resolution of the largest video. Smaller resolutions allow you to make the output video smaller and thus save your disc space, however, this will sacrifice some video quality due to downscaling.

<table>
<thead>
<tr>
<th>Frame Size</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>320x240</td>
<td>4.3</td>
</tr>
<tr>
<td>640x480</td>
<td>4.3</td>
</tr>
<tr>
<td>1280x720</td>
<td>16.9</td>
</tr>
<tr>
<td>1280x960</td>
<td>4.3</td>
</tr>
<tr>
<td>1920x1080</td>
<td>16.9</td>
</tr>
<tr>
<td>1920x1440</td>
<td>4.3</td>
</tr>
<tr>
<td>3840x2160</td>
<td>16.9</td>
</tr>
<tr>
<td>4096x2160</td>
<td>256:135</td>
</tr>
</tbody>
</table>
The aspect ratio is the ratio of the video or photo’s width to its height. The most commonly used aspect ratios are 4:3, used generally for analog TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.

![Aspect Ratio Comparison](image)

A relative comparison of aspect ratios

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with an aspect ratio different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if you add low-quality videos to a project set up to a high resolution (frame size), the small video may be stretched to fit the frame and thus may appear pixellized. For best results, we recommend setting the frame size and aspect ratio to match all or most of the videos and photos you are planning to use.

![Black Bars Example](image)

Examples of black bars appearing when importing videos with a different aspect ratio.

If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes of the Project Settings window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing proportions when entering new values. ![Link](image) – the proportions are constrained, allowing you to set a larger or smaller frame size without changing the aspect ratio, ![Non-Link](image) – you can freely enter the width and height with any proportions. Simply click this button to toggle the two states.

Frame rate
Frame rate or FPS defines the frequency at which frames appear on a display per second. Frame rate affects the smoothness of the video being played. Standard frame rate in most types of videos is 24-30 frames per second. The video plays smoother at a higher value, but the file size rises as well.

Bitrate
Bitrate is the amount of digital information contained in one second of a media file. It is measured in kilobits per second (Kbps). You can control the output file size by changing the bitrate value. There are three types of bitrate available in the video editor:

- **Auto bitrate (CBR)** is a constant value set by the program and calculated according to other already set quality options such as video codec, resolution and frame rate.
- **Constant bitrate (custom CBR)** is a constant manually entered value which is then used to process the entire video. This type of bitrate allows to predict the size of a final media file.
- **Variable bitrate (VBR)** is an automatically picked value that is set within the set quality requirements for the video. VBR will adjust to the image using the optimal values to save the quality: lower values for a static image and higher values for a more dynamic one. But in this case it is impossible to predict the output file size.

Audio settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.

Channels
**Stereo** sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording music; **mono** sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally preferred number of channels, however, some mobile devices record sound only in mono mode.

**Surround sound (5.1)** has the capacity to produce sound using six channels (usually 5 speakers and a subwoofer), which allows it to create the so called participation effect. This technology is often used in home cinema systems, as well as in some game consoles and PCs.

Preview and organize clips
Use the player in the upper right-hand part of the window to preview your project.

Current position
Your current playback position can be controlled using the position marker under the player and on the Timeline.
For precise positioning:

- To move in 0.5 second increments, open the **Playback** menu and choose **Skip Forward by 0.5 Seconds** (Ctrl+Shift+→) or **Skip Backward by 0.5 Seconds** (Ctrl+Shift←).
- To move precisely from frame to frame, use the **Previous frame** (Ctrl+→) and **Next frame** (Ctrl+→) buttons in the player. This will move the position marker exactly one frame backward or forward.
- Use the **Scale** slider to zoom in on the Timeline to make positioning easier.

---

**Playing the video**

1. Move the position marker to where you want to start playback.
2. Click **Play** or press the **Space Bar** key.
3. Click the **Pause** button or press the **Space Bar** again to pause playback.

---

**Arranging clips**

By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your mouse and drop them onto the desired position. To select multiple clips, use Ctrl+click or click and drag to draw a selection on the Timeline.

---

**Working with two monitors**

If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that, click the **Unpin player** button under the player:
The player will then open in a separate window. When you want to return the player back into the main window, click the **Pin player** button in the detached player or close the player window.

**Timeline tracks**
The Timeline at the bottom of the window is your working area where you can organize and edit the clips that make up your video project. The Timeline consists of several tracks for different types of media, that are all synchronized against the time scale at the top. You can imagine the tracks as layers: the uppermost layer appears on top of all others. With the exception of the video track, you can layer several clips on each of the tracks to make your video more dynamic.

**Adding tracks**
With the Timeline that allow work with multiple tracks, you have only three tracks available at the start. To work with several video, audio and title tracks at the same time:
1. Find a **Plus** button at the upper left-hand corner of the Timeline.
2. Select the track you want to add and click it.
3. (optional) Customize the Timeline: change the order of the tracks, hide the content of a track and link tracks to the video track or detach them.

**Video track**
The video track holds videos, pictures, and the transitions between them. You can also place titles, callouts and stickers on the video track if you want them to appear against a black background.
Overlay track
You can use the overlay track to show videos and images on top of the main video track. Simply drag the clips from the main video track up onto the overlay track. Overlay clips are linked to a corresponding clip on the main video track. This way, they will stay in sync even if you move or cut the video clip.
Learn more: Creating overlays

Title track
The title track holds all of your text clips, as well as callouts and stickers. Clips on this track are linked to a corresponding clip on the main video track. You can’t use transitions or effects on any of these clips, but you can animate them.
Learn more: Titles | Callouts | Stickers

Quiz track
This type of track is used only to hold clips with quizzes and usually is added automatically when you create a quiz.
Learn more: Quiz

Independent audio track
The independent audio track is the very last track of the Timeline and it contains audio that is not linked to any clips on the video track. This track is most suitable for background music and clips that don’t need to be synchronized to videos. Both audio tracks show waveforms that visualize the volume throughout the clip, so that you can easily find the quietest and loudest parts. You can also fine-tune the volume using volume curves.
Learn more: Volume curves
Linked audio track
The linked audio track allows you to link audio clips to videos and images on the video track so that the audio clips stay in sync as you edit your project. If you record audio with the Play video during the recording option checked, the audio clip will also appear on this track.

Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these files may be placed on the video track. In that case, drag the audio clip down onto the audio track, and delete the album art from the video track if you do not need it.

Hiding and muting clips
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.

Hiding clips
To hide a clip from view, right-click the clip and choose Hide Clip from the pop-up menu. The clip will not appear in the player or on the finished video until you re-enable it.

Muting clips
To disable a clip’s sound, right-click the clip you want to mute and select Mute Clip from the pop-up menu. The clip will not play in the player or on the finished video.
Disabling tracks

- To hide an entire track from view, click the eye icon to the left of the track you want to hide.
- To disable the sound for an entire track, click the speaker icon to the left of the track.

Undo actions

Click the Undo button on the toolbar or press Ctrl+Z to cancel an action.

If you've cancelled an action but want to return to it, click the Redo button or press Ctrl+Y.

Cutting clips

Splitting clips into parts

1. Select the clip that you want to split.
2. Move the position marker to the moment where you want to cut the clip.
3. Click the **Split** button on the toolbar.

**Cutting out fragments**

**Step 1: Cut the clip at the beginning of the fragment**
1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the **Previous Frame** and **Next Frame** buttons on the player to catch the moment precisely.
3. Click the **Split** button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

**Step 2: Cut the clip at the end of the fragment**
1. Select the second clip you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the **Split** button again. The fragment should now be in a separate clip.

**Step 3: Delete the unwanted fragment**
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the **Delete** key to remove this clip. The clip will be removed, and the remaining clips on the **Timeline** will move to close the gap.

**Trimming clips**

If you only need to cut off some parts at the beginning or at the end of a video or audio clip:
1. Place your mouse pointer over the edge of the clip.
2. Click and drag the edge towards the center of the clip to trim the clip to the desired length.

For more precise navigation:
- Open the **Playback** menu and use the **Skip Forward by 0.5 Seconds** or **Skip Backward by 0.5 Seconds** commands to jump half a second forward or back.
- Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Ctrl+Shift+→ and Ctrl +Shift+→.
**Edit and enhance clips**

Arrange, edit and enhance clips with the tools that you can find on the toolbar and on the More tab.

In a table below see what tools you can use on clips and how to apply them.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split</td>
<td>Set the position marker where you want to separate your clip and cut it.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Turn the clip clockwise.</td>
</tr>
<tr>
<td>Crop</td>
<td>Set on the player the space you want to keep and cut the borders.</td>
</tr>
<tr>
<td>Adjust color</td>
<td>Make the necessary color changes using presets or manually.</td>
</tr>
<tr>
<td>Turn the sound up or down</td>
<td>Click <strong>Clip</strong> properties and use the Volume slider to change audio loudness.</td>
</tr>
<tr>
<td>Normalize the video sound</td>
<td>Select the <strong>Normalize</strong> checkbox in the Clip properties to make the sound smoother.</td>
</tr>
<tr>
<td>Change video speed</td>
<td>Click <strong>Clip</strong> properties and use the Speed slider to make the video faster.</td>
</tr>
<tr>
<td>Reverse the video</td>
<td>Select the Reverse checkbox in the Clip properties to play the clip from the end to the start.</td>
</tr>
<tr>
<td>Change opacity</td>
<td>Move the <strong>Opacity</strong> slider to make the clip transparent.</td>
</tr>
<tr>
<td>Change clip length</td>
<td>To change the clip length move the borders of the clip on the Timeline or use the Speed slider to make the clip faster.</td>
</tr>
<tr>
<td>Make a clip fade in or out</td>
<td>Use the <strong>Fade in</strong> and <strong>Fade out</strong> sliders to make the clip appear and disappear smoothly.</td>
</tr>
</tbody>
</table>

**Edit videos and images**

Photos and videos aren’t always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.
**Picture in picture and overlays**

To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.

[Learn more about overlays](#)

---

**Rotating videos and images**

Nobody likes vertical videos! But don’t worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.

**Rotating by 90 degrees**

1. Select the clip you want to rotate
2. Click the **Rotate** button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.

---

**Fixing the horizon level**

1. Select the clip on the Timeline.
2. Click the **Crop** button on the toolbar.
3. Use the **Angle** slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.
Removing black bars

Cropping

Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.

1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar to open the Crop tool, and a cropping frame will appear inside the player.
3. In the player, set the frame so that the parts you want to cut are outside it. Drag by the corners of the frame to change its size, and drag by the center of the frame to move it.

Use the Angle slider in the Crop and Rotate section on the left to rotate the crop frame.
4. Click **Apply**. A star 🌟 icon will appear on the clip once you've applied cropping.

**Removing crop**

1. Click the star icon on the clip to show the list of applied effects and filters:

2. A tab will open above the toolbar. Find the **Crop** effect and click the **cross** button ✗ next to it to discard the effect.

**Color adjustments**

**Change color settings**

1. On the Timeline, select the clip that you want to adjust.
2. On the toolbar, click the color adjustments button to open the adjustments tool.

3. Select **Easy** mode to use color presets for quick and simple adjustment.
Or select Advanced mode to set your own settings.

If made your own adjustments to the image and want to save them for future use, click Save Adjustments and name your preset. The new preset will appear on the Auto Adjustments tab.

Once you've applied the adjustments, the clip will be marked with a star icon, denoting applied tools or filters.

**Video speed**

Speed up or slow down a video or audio clip with the Speed slide. This can be useful if you're working on a music video and you want the video to match the tempo of the music. Slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and
above. You can also change the speed of any audio clip. If you modify the speed of a video with built-in audio, the audio speed will also be changed.

1. Select the clip.
2. Click the **Clip Properties** button to open the editing tools for the selected clip.

3. Drag the **Speed** slider to set the necessary video speed.

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with a star icon:

**Reversing video**

Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter to create a cool rewinding effect.

1. Select a clip that you want to reverse. You can reverse both video and audio clips.
2. On the toolbar, click the **Clip Properties** button to open the properties for the selected clip.
3. In clip properties, select the **Reverse** option.

When you apply reverse, the clip will appear with a reverse icon on top of it:

**Image duration**

You can change how long each image appears in your video or slideshow either using the clip properties or you can set all images to the same length.

**Changing the length of an image**

1. On the Timeline, select the image clip that you want to edit.
2. Click the **Clip Properties** button to open the properties for the selected clip.
3. In the **Duration** box, enter the new length of the image. Use the following format: *hours: minutes:seconds.milliseconds*. Changes will be applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip appears on the Timeline, the longer it will play in your movie or slideshow.

**Setting the same length for all images**

To set all of the project's images to the same length:

1. Click the **Transition Wizard** button on the toolbar.
2. In the Transition Wizard window, enter the preferred length into the **Image slide duration** box. If you don't want to use transitions to join your clips, select **No transitions** in the box at the top.
3. Click **OK** to set all the images to the selected length.

**Fading video**

In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.

1. On the Timeline, select the clip that you want to fade.
2. Click the **Clip Properties** button on the toolbar. The clip properties will open in the Tools panel above.
3. Set the fade length using the sliders on the General tab.

**Fade in** – how long in seconds it will take to fade in to full opacity at the beginning of the clip.

**Fade out** – how long in seconds it will take to fade out from full opacity at the end of the clip.

Learn more:
- Adding transitions
- Fading audio

## Creating overlays

Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect, add a logo or watermark, create a Chroma Key effect, or insert a short clip without cutting the main video.

### Picture in picture and split screen effects creation

1. You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your project. You can use images in PNG format to add transparent logos.
2. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
3. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.

> Note that a blue line connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip: if you move, cut, or delete the main clip, the overlay clip will also be edited.

You can also layer several overlays at once!

4. Double-click the overlay clip to set it up. An options panel will appear in the player.
5. Open the drop-down box on the overlay panel and choose how you want it to appear on the video.

### Picture in picture

Using picture in picture mode, you can show the overlay video over any part of the screen. This also works for logos.

1. Choose Picture in picture mode.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.
Side by side
Side by side mode works best for creating split screens. You can set the selected clip on the left, right, top or bottom part of the screen using corresponding Side by side effect.

Overlap
In Overlap mode, the video on the overlay track will cover the main video completely. This can be used for a whole bunch of things:
- For videos with transparent areas.
- Cutting out the background with the Chroma key effect
- Inserting a short clip over the main video without having to cut it.

Overlap mode: left - the main clip is hidden; right - Overlap with the Chroma Key effect

Adding a watermark
Adding a watermark to your videos will protect your ownership even if it’s shared all over the Internet. You can add an image overlay with your own watermark or logo, or make a new one using text.

There are two ways to add a watermark. The quickest is to use the Add Logo button on the toolbar:

Or create a watermark by hand:
1. On the Import tab, click Add Files and add the image or video that you want to use as the watermark. For the best look, use images with transparent areas.
2. Drag the watermark clip up to the overlay track to make it appear on top of other videos.
3. Double-click the watermark clip. Change the overlay setting to picture in picture to edit, move and resize the watermark.
You can change the opacity or duration of the watermark:
1. Select the clip and open the **Clip Properties**.
2. Move the **Opacity** slider on the top of the list.
3. In the **Duration** box enter your project length to make the watermark show for the entire time of the video, or simply drag the edges of the overlay clip.

**Text watermark**
1. Click the **Titles** button on the left and pick a nice title style for your watermark.
2. Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.
3. Double-click the titles and enter your watermark text. Pick a font and color. Click **Apply** when you're done.
Creating a freeze frame

A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to emphasize a moment or create a pause to explain things to the viewer.

1. Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous frame and Next frame buttons under the player.

2. Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

3. By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Removing black bars

Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around them. You can remove black bars from videos using one of the ways below.

Use filter
1. On the Timeline, select the clip with black bars around it.
2. Click the Filters button on the left sidebar to open the Filters tab.
3. Find the Vertical fill filter in the Adjustments group and drag it onto the clip.

Manual crop
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more:
Adding filters
Cropping

Fading effects

Make effects and filters fade in using the overlay track.

1. Copy the clip and paste it onto the Timeline.
2. Drag the copy of the clip on the track right above the original. Now you have two identical clips right on top of each other.

3. Double-click the clip on the overlay track and choose Overlap mode in the panel above the player.

4. Apply the effects or filters you want to use onto the upper, visible clip.
5. With the overlay clip selected, click the **Clip Properties** button and select the **General** tab. There, use the **Fade in** and **Fade out** sliders to set the fading time. On the **Applied Effects** tab you can also change **Opacity** if you want to reduce the effect's strength.

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.

Learn more:
- [Applying filters](#)
- [Editing audio](#)

**Editing audio**

**Add an audio**
1. To add music or other sounds to your project, open the **Import** tab.
2. Select **File import** category.
3. Click **Add Files** or just drag your files on the panel.

Also you can use one of the built-in music or sound tracks:
1. Click the **Music** or **Sound** category and take your pick from our royalty-free music collection.
2. Drag the tracks you liked on the Timeline.
Edit an audio
To edit the audio file, double-click the audio track, the settings panel will appear.
• Use the sliders to change the **volume** or the **speed** of the audio.
• Select the **Normalize** checkbox to make quite parts louder and level out the volume.
• Select the **Reverse** checkbox to play the audio backwards.
• Move the **Fade in** and **Fade out** sliders to set the time for the audio to go from complete silence to full volume and visa versa.

Recording audio

**How to record an audio**
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the **Import** panel to open recording options.
4. Set up your recording device and volume.
5. Click **Start Recording** and record the audio.
6. When you’re finished, click **Stop Recording**. You’ll find the recording on the Timeline.
Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as green clips. To change when the audio clip starts playing, drag it along the Timeline, using the ruler at the top for time reference.

Extracting audio from videos
If you want to use a sound track from a movie, you can extract it from a video file and use it in your project.

On the Import tab, click Add Files and choose the video or just drag a video on the panel. The file will be added to the video track on the Timeline.

To trim the parts of the video that you don't need:
1. Move the position marker to the beginning of the fragment you want to keep and click the Scissors button on the toolbar. This way you will cut off the beginning of the video.
2. Now, move the position marker to the end of the fragment you need. Click the Scissors button again, and the fragment will now be in a separate clip.
3. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

4. The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down onto the audio track. If you don't need the video clip anymore, delete it.
You can now work with the extracted audio clip separately.

If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button at the top of the program.
2. In the Export window, switch to the Save Audio File tab.
3. Select an audio format.
4. In the Save to field you will see where on the disk the file will be saved by default. To change that folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.

**Looping audio**

If the music file is shorter than your video, you can loop the audio and have the file play over again until the end of the video.
1. To copy the audio clip, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu.
2. Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the audio length is greater or equal to the video length.
3. Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and drag it to the left.

**Volume curves**

Volume curves help to control the volume of each part of the clip and smoothly increase or decrease the volume.
Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The white line on the image below is the volume curve before you add any points.

Set the volume level
1. Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

2. Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume Point from the pop-up menu.
3. Drag the audio point to the necessary volume level. You’ll notice that the surrounding parts also move with the point to make the transition smoother.
4. Make as many points as you need for each part of the clip where you’d like a peak or a drop in volume.

5. To set the volume level for a part of the clip, you’ll need at least two points. Create a point at the beginning and at the end of the fragment:

6. Create as many volume points as you wish to make a necessary effect.

Linking audio
To make audio clips to stay in sync with videos or images as you edit your project, link it to each other.

To link an audio
1. Select an audio clip on the audio track at the bottom of the Timeline.
2. Drag the track under the video clip you want it to link to.
3. On the left side of the Timeline click the Link button to create the connection between audio and video clips.

Fading audio
You can add smooth fades to the beginning or the end of a clip and create a crossfade effect between audio tracks.

Fade in – how long in seconds it will take to go from silence to full volume at the beginning of the clip.
Fade out – how long in seconds it will take to go from full volume to silence at the end of the clip.

Set up the fading effect
1. Select the clip on the Timeline.
2. Click the Audio Properties button on the toolbar.
3. Set the fade length using the sliders on the Clip Properties panel.
Equalizer

Using the equalizer, you can boost or reduce the levels of specific frequencies.

Set the equalizer
1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Equalizer.
3. Choose an equalizer preset to set the effect quickly. If you want to set more advanced configuration drag the volume bars to adjust the frequencies to the necessary level.
4. To save your own equalizer presets for their further use, click the Save button. In the new window enter a preset name and click OK. The created preset will appear in the presets list.

Noise removal
1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Noise Removal.
3. Use the **Noise suppression** slider to set the amount of noise you want to remove.

   ![Noise suppression slider](image)

*Tip: Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.*

**Audio effects**

Audio effects can transform the sound of an audio clip.

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click **More** on the left sidebar and find **Audio Editing** to open **Audio Effects**.

   ![Audio Effects](image)

3. Click the box in the **Audio Effects** section and choose an audio effect you like.
Removing effects

When you've applied an audio effect to a clip, a star icon will appear on it. Click on the star to see a list of applied effects. Then, select the effect you don't want and click the cross button to discard the effect.

Beat detection

To make your video more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then adjust your video to the beat of the music.

1. On the Timeline, select the music that you want to detect beats for.
2. Click More on the left sidebar and find Audio Editing to open Beat Detection.
3. In the Beat Detection tool, click Detect Audio Beats. The program will analyze the music and place beat markers on the Timeline.
After the beat markers have been placed, you can modify their tempo. Use the **Min. time between beat markers** slider to make the beat slower or faster.

4. Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.

**Removing beat markers**
1. To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select **Remove Beats** from the pop-up menu.
2. To remove all beat markers from your project, right-click the Timeline ruler and select **Remove All Beats** from the pop-up menu.

**Filters**

**Add filters**
1. Click the **Filters** button.
2. Choose **All** to see every filter in the collection or choose the specific category you need. To see the filter’s preview in the player, click on it.
3. To find a specific filter, enter its name into the search box above the filters. Click the heart icon to add the filter you liked to the Favorites group.

4. To add a filter, drag it onto the clip you want to apply the filter to.
Hint: You can apply a filter to several clips at once. Hold the Ctrl key, select the clips on the Timeline and drag a filter onto any of the selected clips. The filter will be applied to all the clips you've selected.

Once you've applied a filter, a star icon will appear on the clip, indicating applied filters and tools.

Remove filters
1. To see the list of applied filters and tools, click on the star icon on the clip.
2. In the list, find the filter that you want to remove.
3. Click the cross button to discard the effect.

Quiz
One quiz clip can include many questions, so there's no need to create an individual quiz for each question. However, if you need questions to appear at different times, create several quiz clips and place where you need them on the Timeline.

Creating quiz
1. On the More tab, open the Video Editing page and select Quiz at the bottom of the column.
2. Click Create Quiz. New fields you can edit will appear on the tab: question type list, question box, answer box and a button Add Question.
3. First, select a type of a question: single choice, multiple choice, open-ended, true or false.
4. Write your question in the Question box.
5. Add answer options. If needed, move the answers up or down by clicking the arrows near the answer boxes. Click the cross icon to delete an answer.
   - Single choice questions require only one correct answer. Select the correct answer by clicking the circle button next to it.
   - Multiple choice questions should have several correct answers. Provide possible answers and check the boxes near the correct options.
   - Open-ended questions do not have any ready-made answers. Instead, a respondent should provide a brief response.
   - True or false questions suppose a statement that can be either true or false. Do not forget to mark which answer is correct.
6. To add more questions, click Add Question and repeat steps 3-5.
7. When you finish making the quiz, click the Preview button on top of the working area, to see how the viewers will see the quiz.
8. To save the changes, click Apply on top of the working area.

Editing a created quiz
To change the contents of the quiz, double-click the clip and make the changes.

Learn more:
Exporting quiz

Transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips.

Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions. Click on a transition to preview it in the player.
2. Pick a style you like and drop it between two clips on the Timeline. Click the heart icon to add it to your favorites list if you like it.

A transition icon will appear between the two clips.

Change transition length
1. Double-click a transition on the Timeline to open transition properties.
2. Enter the new transition length in the **Duration** field. By default, each transition will be set at 2 seconds long. The format is `seconds.milliseconds`. If you want all transitions that are currently in the project to have the same length, select the **Apply to all transitions** option.

3. Click **OK** to apply the changes.

![Transition settings](image)

There are more options to fill the transitions with, such as:
- **Trimmed content** — If you've trimmed the video, the trimmed bits will appear during the transition. If the videos haven't been trimmed, a freeze frame is shown.
- **Freeze frame** — A static frame is shown during the transition.
- **Slow motion** — The part of the video overlapped by the transition is stretched to fill the entire duration.

**Remove a transition**
1. Right-click the transition on the Timeline and select **Remove Transition** from the pop-up menu.
2. If you want to delete all the transitions in your project, choose **Remove All Transitions**.

![Remove transition](image)

**Titles**

**Add text to your video**
1. Click the **Titles** button on the left side of the window to view the titles collection.
2. Click on a title style to preview it in the player and choose the titles you want to use. To add titles to your favorites, click the heart icon.
3. Pick a title style and drag it onto the title track of the Timeline. Put it right above the video track, onto the time where you want them to appear.

![Adding titles](image)

4. You can link titles to the clips by clicking the link button on the left side of the title track, so that the titles will move with the clip, or you can leave them unlinked.
Editing titles
To change the titles, double-click the title clip on the Timeline. The Settings panel will appear.

Change text formatting on the Text tab. On the clip tab, you change the duration of the clip or the animation speed. The New Preset tab will help you save a preset from your text and its formatting.

Timer

Add a timer
1. Click the Titles button on the left sidebar to open the list of the text styles.
2. Find the Timer title style. Use the search bar or click the Basic group to filter the styles.
3. Drag the Timer titles onto the title track of the Timeline. To change the length of the timer, drag the edges of the clip.

Edit the timer
1. Double-click the timer clip on the Timeline.
2. Edit the text formatting on the Text tab, if needed.
3. Switch to the Timer tab.
4. Change the time format to the suitable one, for example, ss:zzz.
5. In the From field, set the starting time. If you select to set a countdown, it will also begin from the time you set in the From field.
Stickers

Add stickers
1. Click the **Stickers** button on the sidebar to open the list of stickers.
2. Click on a sticker to preview it in the player and choose which you want to use. To add a sticker to your **favorites**, click the heart icon.
3. Select the sticker and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track. Change the length of a sticker to make it fit the clip.

Edit a sticker
1. Double-click the clip to open the sticker settings.
2. Set the duration of your sticker.
3. Click **Apply** to save the changes.
4. To change the sticker's position on your video, double-click a sticker clip. In the player, drag the corner of the frame to change its size, and drag the center of the frame to move the sticker. To rotate the sticker, click and drag the white dot at the top of the frame.
5. Click **Apply** when you're finished.
Transitions cannot be applied to stickers, but you can animate them.

Learn more:
Animation

Callouts
Using callouts, you can annotate your video with arrows, icons, and other shapes.

Add callouts
1. Click the Callouts button on the left sidebar to open the list of callouts.
2. Click a callout to preview it in the player and choose which you want to use. To add a callout to your favorites, click the heart icon.
3. Select the sticker and drag it onto the Timeline.

Edit a callout
1. Double-click the clip to open the callout settings.
2. Set the duration and animation speed of a callout.
3. Switch to the Color tab to change a callout's color, outline and set its opacity.
4. If you're editing a callout from the Arrows category, on a Style tab you can also change a style of an arrow and its heads.
5. Click Apply to save the changes.
Adjust the callout in the player
1. Double-click a callout clip.
2. In the player, drag the callout by the frame points to resize and rotate it.
3. Drag the callout with the cursor to change its position on the screen.

See also:
Timeline tracks
Adding titles

Animation
You can move objects any way you want and make creative appearances.

Add animation
1. Add the background onto the main video track.
2. Add the object you want to animate.
3. Click More and on the Video Editing tab choose Animation.
4. The **Easy** animation tab includes presets with a simple animation, that you can quickly drag and add to a clip. To create your own unique animation, switch to the **Advanced** tab.

**Advanced mode**
1. Select the clip you want to animate and place the position marker where you want your animation to start.
2. In the **Animation** panel, click **Add Animation**.
3. In the player, you will see a frame appear around the object. Use it to set the position of the object. On the Timeline, two points will appear on the clip. They are called **keyframes**. The **first** point is the original position of the object. The **second** point is its end position after the animation. The **distance** between the two points determines the animation speed.

**Edit the keyframes**
1. On the Timeline, double-click a keyframe to edit it.
2. In the player, use the frame to move the object to where you want it to go.
   - To change the object's **size**, drag by the corners of the frame.
   - To **rotate** the object, drag by the white dot at the top of the frame or use the **Angle** box in the Animation panel. Note that if you want to make the object spin, you can rotate it to a maximum of 180 degrees in a single keyframe.
   - To make the object fade in or out, use the **Opacity** slider in the Animation panel.
3. To change how fast the object moves, move the keyframe point on the clip:
   - Move the points closer together to make the animation go faster.
   - Move the points farther away from each other to make it go slower.
To add another keyframe, move the position marker to where you want to place it in the clip and click Add Keyframe on the Animation panel. If you add it between two existing keyframes, it will create an intermediate position.

**Reset a keyframe**

To make a keyframe go back to its original position, right-click the keyframe point on the clip and select Reset Keyframe in the pop-up menu.

**Remove keyframes**

1. To remove one keyframe, right-click the keyframe point on the clip and select Remove Keyframe in the pop-up menu.
2. To remove all keyframes and delete the animation, right-click any of the keyframe points and select Remove All Keyframes.

**Pan and zoom**

You can control the camera movement using two keyframes and smoothly move from one frame to another.

**Add the Pan and Zoom tool**

1. On the Timeline, select the clip that you want to zoom.
2. To open the Pan and Zoom, select More on the left sidebar and find the Pan and Zoom tool in the Video Editing.
3. Select one of the presets and drop it on a clip. This will add two keyframes to the clip. The camera will move between these two keyframes and you can set up camera movements from one point to another.
4. To change the *beginning* keyframe, double-click the first point of the clip and to change the *ending* keyframe, double-click the second point of the clip. Then use the frame in the player to set the zoom level for each point of the camera movement.

To change the length of the zoom effect, move a keyframe left or right. To move the zooming effect on the clip without changing its length or other settings, move it along the clip. Repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

**Add the Pan and Zoom effect to all the image clips automatically**

1. Select the images on the Timeline.
2. Click *Transition Wizard* button on the panel above the Timeline.
3. Select the *Enable Pan and Zoom effect* checkbox.
4. Click *OK* to apply the effect to the clips.

**Remove zoom**

To remove a pan or zoom effect, right-click a keyframe and select *Remove All Keyframes* to clear all zoom effects from the clip. To remove only the selected keyframe, select *Remove Keyframe*. 
Stabilizing video

If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you walk or move while filming.

Stabilize a video

1. On the Timeline, select the clip you need to stabilize. To the process shorter, you can cut the video into smaller segments.
2. On the left sidebar, click the More button select Stabilization from the list of tools.
3. Click Stabilize to open stabilization options. The Stabilization window will open.
4. Set up the stabilization parameters:
   - **Accuracy** affects the analysis precision of the video.
   - **Shaking** sets how strongly the shaking is visible on the video.
   - As well as **Advanced Settings**, if required:
     - **Radius** — when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area will be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.
     - **Smoothing** limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.
     - **Edge cropping** eliminates distortion artifacts like blurred areas from the video. There are several options such as:
       - None: the edges will remain as they are. Best results if there is little shaking on the video.
       - Fixed: the video is cropped to one size to cut off some of the edges.
       - Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.
5. Click **Stabilize** to start processing the video. This may take a while depending on the length of your video and the selected parameters.
6. To save the result, click **Apply** and you will replace the clip on the Timeline with the stabilized video. The stabilized copy of the file will be created under “\My Videos\Movavi Academic\Stabilized”. This copy will be used in the project. If you delete the stabilized copy, you will lose all the changes made. If you don't have enough space to save the stabilized copy, you can free some disk space and try again, or save stabilized copies on another disk:
   1. Open the **Settings** menu and choose **Preferences**.
   2. Switch to the **Files** tab.
   3. Find the “Store stabilized videos in” box and click the button on the right to choose another folder on a drive.
   4. Click **OK** to accept the changes.
   5. Try stabilizing the video again.

**Highlight and conceal**

This tool will help you to control the focus in the frame, and blur or darken parts of the video.

**Apply the Highlight and Conceal tool to the video**

1. On the Timeline, select the clip that you want to edit.
2. To open the **Highlight and Conceal**, click the **More** button on the left sidebar, and choose Highlight and Conceal in the **Video Editing** tab.

3. Choose **Conceal** if you want to hide an object, and **Highlight** if you want to make an accent on the object.
4. Choose a shape for the mask: you can use a **rectangular** or an **elliptical** one.
5. Choose a masking effect: **Blur**, **Matte** (black cover-up) or **Pixels**. Use the options below to set up the mask:
   - **Opacity** – makes the mask more transparent (for matte and blur);
   - **Feathering** – makes the edges of the mask softer (for matte and blur);
   - **Outline** – adds a white outline around the mask.

6. To change the size and shape of the mask drag its corners in the player, drag by the center of the mask to move it on top of the object.
If you want to cover up or highlight more than one object, click Add Mask at the top of the setting panel to create another mask.

7. Click Apply on the Highlight and Conceal panel to save the changes.

**Chroma key**

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.

**Add Chroma Key**

1. Add the video or image clips that you want to use as the foreground and the background.
2. Select the foreground video and move it up, onto the Overlay track.
3. Double-click the foreground video to open Clip Properties.
4. To make the foreground video completely cover the background video, select the Overlap mode.
5. On the left sidebar, click the More button and in the Video Editing list find Chroma Key.

6. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color you've picked will become transparent.

7. Make other adjustments to the effect:
   - Tolerance — Set how many similar shades of the selected color should also be removed.
   - Noise — Choose how sharp the object’s edges should be.
   - Edges — Choose how thick the object’s edges should be.
   - Opacity — Set the transparency of the background.

8. Finally, click Apply to accept the changes.
Exporting videos

When you’re done with your project, you’ll need to export it as a media file to be able to play it on the devices. This section will guide you through the process of exporting your project to a popular video format. If you want to find out more about other ways of saving videos, see the following guides:

- Saving videos for devices
- Uploading videos online

Export a video

1. To start saving the video, click the Export button under the player. The export settings window will open.

2. Choose a format for saving the video in. Some formats allow you to choose between video codecs. If you don’t know which format to choose, try using MP4. The MP4 format is supported by most platforms and operating systems. At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to the limitations of digital data compression.

The GIF format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some image viewing programs or in any web browser.
Advanced settings
If you want to change the resolution, aspect ratio, or other settings, click the **Advanced** button to view and edit the project settings.

If your project is heavy on small details and filters, you can select **High** or **Highest** quality to export the finished video with a higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, **Good** quality will provide a nice result at a small file size.

3. Name your file and choose a destination folder.
In the Save to field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path manually into the box. Name your video in the Title field: the project’s name will be filled in for you by default.

4. Click the Start button to begin processing the video file. This may take up to a few minutes.

Exporting quiz

To save a video that contains a quiz, you need to switch to a specific tab on the export window.

1. To start saving the video, click the Export button under the player. The export settings window will open.

2. Switch to the Save Video with a Quiz tab and select where you want to save the video. Computer — save a folder with the video only to disk. Cloud — upload the video to Movavi Cloud and share the link.
3. Name your video, select the resolution and choose a destination folder.

4. To see the answers to the quiz, you should select the **Send me the results by email** checkbox and enter your email address in the box below.

5. Select if the answers from the viewers should be anonymous or not.

6. The video will be saved to a folder with an .MP4 and .html files. You can share this whole folder, so that the viewers could open the .html file and take the quiz.

**Export only audio**

This section will guide you through exporting just the audio track of your project.

**Export an audio**

1. Click the **Export** button in the bottom right-hand corner of the Editor to open the export settings window.
2. Click on the Save Audio File tab in the left part of the Export window.
3. Select the format you’d like to save the audio in.

While **MP3** is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the original files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC audio, and vice versa – high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.

4. Name your file and choose a destination folder. In the Save to field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path manually into the box. Name your video in the Title field (the project’s name will be filled in for you by default).
5. Click the Start button to begin processing the video file.
Export for devices

This guide will help you export your video project for playing on mobile phones, tablets, and other devices.

1. Click the **Export** button under the player to open the export settings window.

2. In the left part of the window click on the **Save for Devices** tab.

3. Choose a format.

On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running iOS (iPhone, iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as PlayStation console. If your device is not on the list, choose **Other**.
4. Name your file, choose a destination folder and set a desired quality. In the Save to field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path manually into the box. Name your video in the Title field: the project’s name will be filled in for you by default.

5. Select High or Highest quality to export the finished video with a higher bitrate. This will increase the size of the output file, but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

6. Click the Start button to begin processing the video file. This may take up to a few minutes.

Export for TVs

This guide will help you export your video project for playing on Smart TVs.

1. In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

2. In the left part of the window click the Save for TVs tab.

3. Choose a TV preset. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.
4. Name your file, choose a destination folder and set a desired quality. If your project is heavy on small details and filters, you can select *High* or *Highest* quality to export the finished video with a higher bitrate. This will increase the size of the output file, but will preserve better quality. For most other projects, *Good quality* will provide a nice result at a small file size.

In the **Save to** field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the **preferences**. To set a different folder, click the **Browse** button and choose the folder in the Windows Explorer window, or enter the path manually into the box. Name your video in the **Title** field: the project's name will be filled in by default.

5. Click the **Start** button to begin processing the video file. This may take up to a few minutes.

### Uploading online

After you finish your video, you can share it to YouTube, Vimeo, Google Drive or Movavi Cloud right from the export window.

1. Click the **Export** button under the player.
1. In the left part of the window click the **Upload Online** tab.

2. On the Upload online tab select the service you would like to upload your videos to: YouTube, Google Drive, Vimeo or Movavi Cloud.
3. Click **Sign in**. The authentication page will open in your browser. Sign in to your account and click **Allow** to let Movavi Academic upload videos.

**Upload to YouTube**
1. Fill in the **title and description** for your video.
2. Add some **tags** to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a **category** to help viewers find relevant content.
4. Open the **Privacy** box and choose who you want to see the video:
   - **Private** – videos can only be seen by you and the users you choose.
   - **Public** – videos can be seen by and shared with anyone.
   - **Unlisted** – videos can be seen and shared by anyone with the link.
5. On the bottom of the window, browse a folder where you want your video to be saved to.
6. Click **Upload** to save and upload your video.

**Upload to Google Drive**
1. Fill in the **title** for your video.
2. Select a Google Drive folder where you want your video to be uploaded. Click the plus icon to create a new folder on the drive straight in the export window or click the refresh icon to see a folder that you’ve created in a web browser.
3. Open the **Privacy** box and choose who you want to see the video:
   - **Only me** – videos can only be seen by you and the users you choose.
   - **Get shareable link** – videos can be seen and shared by anyone with the link.
4. On the bottom of the window, browse a folder where you want your video to be saved to.
5. Click **Upload** to save and upload your video.

**Upload to Vimeo**
1. Fill in the title and description for the video.
2. Set the level of privacy:
   - **Anyone** – any person can watch the video.
   - **Only people I follow** – only people you're subscribed to can watch the video.
   - **Only me** – nobody, but you can access the video.
3. Select the resolution of the video and add tags.
4. On the bottom of the window, browse a folder where you want your video to be saved to.
5. Click **Upload** to save and upload your video.
Upload to Movavi Cloud
Movavi Cloud is a cloud storage developed by Movavi, that provides a space for 1 GB of video a month for free.
1. Fill in the title of the video.
2. Set the resolution.
3. On the bottom of the window, browse a folder where you want your video to be saved to.
4. Click Upload to save and upload your video.

Video Editor preferences
To open the program’s preferences:
1. Click the Settings menu.
2. Select Preferences.

The Preferences window will open. The preferences are organized into tabs. Click a tab to open the relevant options.
See also:
General preferences
File preferences
Sharing preferences
Acceleration preferences

General preferences

Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the changes.

Automatically check for updates – select this option and you’ll be notified whenever a new version is available. Updates within your version are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

I give consent to send anonymous usage stats to Movavi – check this box to let the program send usage statistics to our development team and help us to fix all the problems in the program much faster. The data contains no personal information, will not be disclosed to third parties and will be used for software improvement purposes only.

Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you see an error message when you start the program.
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If Movavi Academic runs without showing an OpenGL error message, this option is not recommended.

Learn more about OpenGL troubleshooting

Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is completed.
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different location.

**Save project files to** – a folder for saving and opening projects. This folder will also store any autosave files for new projects. You can use the autosave file to restore your work in case of an error or force close.

**Save output videos to** – a folder for exporting media files.

**Store audio recordings in** – a folder for the audio clips that you record in the Editor.

*If you delete these audio files, the audio recordings in the project will also be unavailable.*

**Store stabilized videos in** – a folder for a stabilized copy of the original when you stabilize a video.

*Don't delete these files while you are working on the project, or you'll have to stabilize the files again.*

Changing where the files are stored

Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in another way.
1. Click the button with three dots next to the folder you want to change.
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.
3. Click Select Folder to use this folder.

Sharing preferences

On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.

1. Select a service to upload a video to: YouTube, Vimeo or GoogleDrive.
2. Click Sign In.

2. Sign in to your account.
3. On a web page, allow Movavi Academic to upload videos to your account.

4. Return to Movavi Academic. You are now logged in and can upload videos. If you need to change the account, click Sign Out.

Acceleration preferences

Fast Track HD Acceleration

Fast Track HD Acceleration provides smooth and fast program running. By enabling HD clips optimization in the Preferences menu you allow the video editor to create copies of the project files in a smaller size and then use them in the project instead of the original ones. To enable this feature you need to have free disk space, so the Editor can store and use the copies. Once you finish editing and begin export, high-quality files will replace all the temporary optimization copies.
Record computer screen

With the screen capture module, you can record any part of your screen with audio and save the resulting video in any format. When you click the **Record Screencast** button, you will see a control panel window where you can set up your capture preferences and an orange frame which allows you to select which part of the screen you want to record.

**To start recording**
Click **Record Video** in the launcher window.

If you are already in the middle of editing, click **Capture Screencast** in the Import section or the **REC** button on the toolbar.
Control panel

The compact control panel is the first thing you see when you launch video recording in Movavi Academic. The panel provides you with quick access to all basic tools without blocking the content on your screen.

By default, the panel will be located at the right side of your screen, but you can pin it to any side you like.

Note that the panel cannot block the Windows taskbar (located below by system default).

• Click either of the camera buttons to start the area selection tool: to take a screenshot, to record screen.
• Click the cogwheel button to open Preferences.
• Click to hide the panel. Click to show it again.
• Clicking will minimize the program to notification area. You can access the program from the notification area menu.

Recording video from screen

This tutorial will show you how to record and save a video from what's happening on your screen.

Set up the capture area
1. Click the camera button on the control panel or press F10. The area selection tool will start.
2. Select the part of the screen that you want to record:
   - Click and drag on the screen to select the capture area.
   - To record a window or a window panel, hover your mouse pointer over it and click once a frame appears around it.
   - To record the full screen, click in any part of your screen (make sure no windows are selected!).

Set up the sound and webcam
By default, only the system sound recording is on. To enable webcam and microphone recording, click the corresponding icons:
- Webcam off/on
- Microphone audio recording off/on
- System audio recording off/on

If you have more than one microphone connected, select the one you need from a list next to the mic icon.

Start recording
When you're ready to begin, click the REC button. You will be given a 3-second countdown before the recording begins.

Use these keyboard shortcuts to control the recording process:
- F9 - pause the recording
- F8 - take a snapshot of the capture area
- F10 - end capture and save the recording

Tip: these are the default hotkeys. You can change them in the Keyboard Shortcuts section of the Preferences.
When you're ready to finish your recording, click **Stop** on the recording panel or use the F10 keyboard shortcut.

**Edit the recording (optional)**
When you finish recording, an editing window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or save it in a different format.

Learn how to cut and edit videos
Learn how to save the edited recording

**Record audio only**
Besides screen activity, you can just as easily record online music, radio, podcasts, and voice input as standalone audio files.

**Set up capture area**
1. Click the **camera** button on the control panel or press F10. The area selection tool will start.
2. If you need the video as well, select the area you want to record. If an audio file is all you need, select the smallest capture area possible (16x16) in any part of your screen. This way, you will avoid taking up unnecessarily much disk space during recording.

**Set up the audio**
On the recording panel, choose which audio sources you want to record from:

**Recording system sounds**
To record music, online videos, and any other sounds playing on your computer, click the **system audio** button.
Recording microphone audio
To record sound from a microphone or any other recording device connected to your computer, click the microphone button. If you have more than one recording device, click the arrow next to the button and select the device you want to record from.

Record the audio
Click REC when you're ready to begin recording.

To end the recording, press F10 or click Stop on the recording panel.

Save audio file
When the recording is finished, it will be added to the Timeline of the video editor, where you can edit, cut and save it.

Troubleshooting audio
My device is not available in the list.
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.

1. Try re-connecting the device.

2. If that didn't help, right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The Sound settings window will open.

3. Look for your device in the list:
   • If the device is working correctly, it should be marked with a green checkmark.
   • If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled Devices and Show Disconnected Devices are selected.
   • If you still cannot find the device, download a driver for this device from the manufacturer's website and install it. This should help your system detect the device.

4. Try enabling the device:
   • If the device is listed as Not Plugged In, try plugging in the device again.
   If the device is listed as Disabled, right-click the device and choose Enable.

Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click. You can enable mouse cursor effects on the effects panel.
By default, the cursor will be highlighted yellow and the mouse clicks red and blue for left and right mouse buttons respectively. However, you can set up the effects the way you like.

**Open the mouse cursor options**
1. On the control panel, click the cogwheel button to open Preferences.
2. In the Preferences window, switch to the Effects tab.

**Enable the cursor**
Select Show cursor on recording. This will make the cursor visible on recordings. To make the cursor invisible, disable this option.
Highlight cursor actions (optional)
To make the cursor visible even better, you can highlight it or enable a special effect for clicks.

Highlight cursor
A semi-transparent circle will appear around the cursor, making it easier to track.

1. Select the **Highlight cursor** option.
2. (optional) The default highlight is yellow. To change the highlight color, click the square on the right and pick the new color.
3. (optional) Use the **Size** slider to make the highlight smaller or larger. The cursor itself will remain the standard size.

Hover your mouse over the square on the right to preview the highlight.

Highlight clicks
Concentric circles will appear for every click, color-coded for two mouse buttons.

1. Select the **Highlight clicks** option.
2. (optional) Click the left square to set the color for the left mouse button.
3. (optional) Click the right square to set the color for the right mouse button.

Mouse click sound
A clicking sound will play whenever you click the mouse.

1. Enable the **Mouse click sound** option.
2. (optional) The default clicking sound has already been selected for you. If you want to use your own sound, open the drop-down box and choose **Add sound**. Then, open the sound file that you want to use.
   You can use WAV, MP3, AIFF, and AU files.

Recording keystrokes
If you’re making a tutorial that uses keyboard shortcuts, it’s helpful to display them on screen for your viewers. Enable keystroke recording to show the keys you pressed at the bottom of the video.
1. On the effects panel, click the keyboard button.

2. To enable keystroke recording, select one of the options:
   - All keystrokes — each key you press will appear on screen, including letters and numbers.
   - Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will show up on screen. Letters and keys that do not cause an action will not be displayed.

To turn off keystroke recording, click the keyboard button again.

Tips:
- Avoid entering any passwords or other sensitive information while you’re recording a video with keystroke recording: if you share the video, your viewers will be able to see each character you type.
- Keyboard shortcut recording does not work with the Windows key.

Scheduling

Any recording can be scheduled for a later time. You can use this to automate your recordings or capture late-night webinars.

Set up your recording
Scheduled recordings will start with the currently selected options (system sound, webcam, etc.) Before scheduling the recording:

1. (optional) Default capture area for scheduled recordings is full screen, so if you want to change it, click the camera button on the control panel and select the part of the screen you want to see on your scheduled recording.
2. To enable system sound recording, click the speaker button on the recording panel and make sure it is enabled and highlighted green.

Schedule recording
1. On the control panel, click the cogwheel button to open Preferences. Switch to the Scheduler tab.
2. Select Schedule recording.
3. Click the Add Task button.
4. A task template will appear. Fill in the details for the task:
   - Title - the name of your recording
   - Date and time - the moment recording should start
   - Duration - how long the recording should last (e.g. if you want to record an hour long webinar, set this at 01:00:00)
   - Capture area - by default, the program will record full screen. However, if you’d like to avoid recording extra parts of the screen, you can select Current area. Be careful: the program will capture the area selected on screen at the moment your recording starts! If you don’t select the new area, last recorded area will be used.

5. Click Create to add the task to your recording schedule.

6. Finally, click OK in the Preferences window to save the changes. After the recording is finished, the recording file will be stored in *.mkv format in the output folder with your other screen recordings.

Please note that if you haven’t yet activated the program, the maximum capture time is 5 minutes for each video. To learn more about activating Movavi Academic, see the Activating Software section.

If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.

### Time limit

When you record a long webinar or online video, you can limit the recording to a specific time and it will stop automatically once the time is up. This way, you don’t have to wait around for the video to end.

1. On the control panel, click the cogwheel button to open Preferences. Switch to the Scheduler tab.
2. Select the Set time limit for recording option.
3. Set Duration by entering the time limit as hours:minutes:seconds.
4. Click OK to enable the time limit.
   Note: the limit will work on all your next recordings in the current session only, until you restart the program.

5. Click the REC button on the recording panel to begin recording. After the specified time is up, the recording will end automatically.

**Taking screenshots**

1. On the control panel, click the screenshot button 📸.

2. Your cursor will turn into a crosshair. Select the part of the screen that you want to capture:
   • To capture a window or a window frame, hold your mouse pointer over the window and click after a frame appears around it.
   • To capture a part of the screen, hold the left mouse button and drag diagonally to draw a rectangle.
   • To capture the entire screen, click on any empty area of your desktop.

3. A frame will appear over the selected area. You can now edit your screenshot:
   • Select a tool you want to add to your screenshot: Line ✏️, Arrow ⬅️, Frame 📦 or Highlighter ✍️. Hold the left mouse button and drag to draw a shape.
   • Change the color 🌈 and width 🔊 of your shape.
   • Drag by the green arrow circle ⬅️ or the white circles on the edges to resize the element; rotate by dragging the green circle left or right.
   • If you need to move the capture area, click the Drag-area mode 🗓️ button.
4. Choose what you want to do with your screenshot:

- Click the **Copy** button to copy the image to clipboard without saving the screenshot to a file.
- Click the **Save** button to save the image file and open its containing folder.
- Click the **Share** button to share the image to Movavi Cloud, WhatsApp, Telegram, and Google Drive or send it in an e-mail.

*Where are the screenshots stored?*

By default, the screenshots are stored in the "\Videos\Movavi Academic\Screencasts\Screenshots" folder of your user. You can change where the files are saved in the Files section of the Preferences.

**Screen recorder preferences**

To open the program settings, click the **cogwheel** button on the control panel:

The preferences window will open. The preferences are organized into eight categories: **General**, **Files**, **Keyboard Shortcuts**, **Video**, **Webcam**, **Effects**, **Scheduler** and **Sharing**.

**General preferences**

The **General** tab allows you to change the basic behavior of the program.

**Basic settings**
Every time before the recording starts, you will see a 3-second countdown. This gives you time to prepare for your recording. Select this option to turn the countdown off and start recording immediately.

The recording panel appears when you start recording. It’s semi-transparent and it will not be recorded on top of your finished video even if you record fullscreen, but you can hide it if necessary.

In case the blinking irritates you, check this box. The frame will stay still during recording.

To record only the main window panes (no frames, menus or browser tabs), Movavi Screen Recorder needs access to your screen.

When recording a video, the webcam, main onscreen video, external audio, etc. will be recorded as separate streams, like layers. This can be useful for editing the video later, so you can edit them separately.
Use software OpenGL implementation (advanced)
This option can troubleshoot OpenGL problems for some graphics cards.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

Save extended logs for troubleshooting
In case you experience trouble using the program and contact our support team, they might ask you to collect logs. The logs contain the program’s actions for some period of time, as well as important error reports and descriptions. Extended logs give the most amount of information which may be essential to solving your problem.

Automatically check for updates
The program will notify you if a new version is available. Minor updates are absolutely free (for example, from v.1.3 to v.1.4). For major updates users with purchased Movavi Academic license will get a considerable discount.

I give consent to send anonymous usage stats to Movavi
Enabling this box will allow Movavi Academic to send us anonymous data about how you use the program. This data does not contain any personally identifiable information and is only used for improving our software. You can find more information about how we use the statistics on our Movavi Improvement Program page.

Use alternative capture mode
If you get an error message when you start or stop recording your screen, try this option.

(For Windows 8 and above)

File preferences
In the Files section of the preferences, you can change where your captured files are stored. To change a folder location, click Browse and select a new folder.
Save output videos to...
This is where all your video recordings are saved.

Save screenshots to...
This is where all your new screenshots are saved. You can also find your recent screenshots in the editor window.

**Keyboard shortcuts**

The **Keyboard Shortcuts** tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process. On the right, you can see keyboard shortcuts for every action.

**To change one of the shortcuts:**
1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box now will display your custom shortcut.
3. Click **OK** to apply the changes. To reset all the keyboard shortcuts to their original state, click the **Reset to Default** button.

If there's a keyboard shortcut you want to use in other software while Movavi Academic is running, check the **Disable keyboard shortcuts** box.

In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.

**Video preferences**
On the Video tab, you can choose how the videos are recorded and saved, change the preferred audio quality, including the sample rate, number of channels, and bits per second.

### Frame rate
The frame rate defines how many frames will be captured each second and affects the smoothness of motion in the video. A lower frame rate will result in smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per second.

### Sample rate
The first number is the audio sample rate, measured in Kilohertz (kHz). This is the number of digital samples taken each second to record sound. Higher sample rate usually means higher quality. 44.1 kHz is the recommended sample rate, which corresponds to the human hearing range.

### Channels
- **Mono** uses only one audio channel, which saves some disk space.
- **Stereo** uses two audio channels, which allows distinguishing the direction a sound is coming from and usually sounds more natural.

### Bit depth
The program will record audio at 16 bits, which is the standard bit depth for most audio recordings. This means that every sample contains 16 bits of information to encode sound.

## Webcam preferences
The Webcam section of the preferences allows you to set up your webcam for recording it on top of the main video.
Enabling the webcam
1. Connect the camera to your computer and wait until your system installs the necessary drivers.
2. In the Webcam preferences section, select the camera you want to use from the Use this webcam box.

If the camera does not appear in the list, try manually installing the driver that came with your camera. You can use the preview square on the right to check that the camera is working properly.

Webcam properties
Clicking the Settings button will open the camera's properties. These properties are different for each manufacturer, but generally you can use them to calibrate the brightness, contrast, and exposure of your camera.

Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable decrease in quality.

Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work best for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is 20-30 frames per second.

Video size
Use the video size slider to set the size of the webcam overlay relative to the main video.

Position
Use one of the position options to choose where your webcam overlay will be placed on the original video.

Effects
In the Effects section of the preferences, you can set up the visibility of your mouse and keystrokes.

Cursor options
Select Show cursor on recording to make the cursor visible to your viewers.

Highlight cursor
This option will add a bright circle around the mouse cursor to make it more visible.
1. Select the Highlight cursor option.
2. Click the square on the right to choose the highlight color. Use the Alpha channel box to change its opacity.
3. Use the size slider to change the size of the highlight circle.

Hint: hover your mouse over the preview square on the right to see how it will look on the recording.

Highlight clicks
This option will flash a circle around the cursor for every click. You can set two different colors for the left and right mouse buttons.
1. Enable the Highlight clicks option.
2. Click the left square to set the color for the left mouse button.
3. Click the right square to set the color for the right mouse button.

Mouse click sound
A clicking sound will be played every time you click the mouse to draw attention to your actions.
1. Enable the Mouse click sound option. The default mouse click sound will be used.
2. (optional) If you have a file with a different sound effect you want to use, open the box under Mouse click sound and choose Add sound. Then, open the audio file with the sound effect. You can use WAV, MP3, AIFF, and AU files.

**Keystroke recording options**

- **Keyboard shortcuts only** – only functional keys and key combinations (for example, Alt+Shift, or Ctrl+C) will appear on the video.
- **All keystrokes** – all key presses, including letters of the alphabet, will appear on the video.

*Hint: avoid entering passwords when this option is enabled if you don’t want everyone to see your password.*

**Scheduler**

In the **Scheduler** section of the preferences, you can start and stop recordings automatically.

![Scheduler interface](image)

**Automatically ending a recording**

1. Select the "Set time limit for recording" option.
2. Enter the duration of the recording as hours: minutes: seconds.

**Scheduling a recording**

To start and end a recording automatically:

1. Select the "Schedule recording" option:
2. Click 'Add Task' button.
3. Fill in the details and click Create to add your task to the recording schedule.

The Movavi Academic application must be running at this time for the recording to begin.

Learn more:

- Time limit
- Scheduling

**Sharing preferences**

The **Sharing** tab allows you to manage your Google Drive account used to upload videos to.
To sign in to your account:
1. Click **Sign In**. The authentication page will open in your browser.
2. Sign in to your account and click **Allow** to let Movavi Academic upload videos.

**Help and support**

Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.

**How to reach us**

By e-mail: support@movavi.com

[Fill out a support form](#)

We guarantee a response within 3 business days!

If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information about your system will allow us to help you faster.

**Frequently Asked Questions**

[How to remove the trial watermark](#)

[What are the system requirements for using Movavi Academic?](#)

[What formats does Movavi Academic support?](#)

[More frequently asked questions](#)

**Keyboard shortcuts**

Editing video becomes much faster and easier if you learn a few basic keyboard shortcuts, especially if you're using a touchpad. You can find the list of shortcuts if you open the **Help** menu and select **Keyboard Shortcuts**.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add media files</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>New project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open project</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save project as</td>
<td>Ctrl+Shift+S</td>
</tr>
<tr>
<td>Split clip</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Insert freeze frame</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Add keyframe</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Full screen view</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td>Skip forward 0.5 seconds</td>
<td>Ctrl+Shift+→</td>
</tr>
<tr>
<td>Skip backward 0.5 seconds</td>
<td>Ctrl+Shift+→</td>
</tr>
<tr>
<td>Next frame</td>
<td>Ctrl+#</td>
</tr>
<tr>
<td>Previous frame</td>
<td>Ctrl+←</td>
</tr>
</tbody>
</table>

*For the Animation and Pan and Zoom tools*
System requirements
Note that Movavi Academic may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are not met.

<table>
<thead>
<tr>
<th>Minimum system requirements</th>
<th>Recommended configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows® 7/8/10 with latest service packs and patches</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel®, AMD® or compatible processor, 1.5 GHz and above</td>
</tr>
<tr>
<td>Graphics card</td>
<td>NVIDIA® GeForce® series 6 or higher, AMD Radeon™ R600 or higher graphics card with up-to-date drivers</td>
</tr>
<tr>
<td>Resolution</td>
<td>1024x768, 32-bit color</td>
</tr>
<tr>
<td>RAM</td>
<td>1920x1080 or higher</td>
</tr>
<tr>
<td>Available disk space</td>
<td>280 MB for installation</td>
</tr>
<tr>
<td></td>
<td>500 MB for ongoing operations</td>
</tr>
<tr>
<td>Administrator permissions</td>
<td>5 GB for ongoing operations</td>
</tr>
<tr>
<td></td>
<td>Additional space required to save captured video and export projects.</td>
</tr>
<tr>
<td>Additional features</td>
<td>Intel® hardware acceleration requires a compatible Intel processor supporting Intel HD Graphics™ 2nd generation or higher</td>
</tr>
</tbody>
</table>

Supported formats
Here you can view the list of formats and codecs supported by Movavi Academic.

<table>
<thead>
<tr>
<th>Video Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
</tr>
<tr>
<td>3GPP, 3GPP2</td>
</tr>
<tr>
<td>(.3gp, *.3g2)</td>
</tr>
<tr>
<td>ASF – Advanced Streaming Format (.asf)</td>
</tr>
<tr>
<td>AVI – Audio Video Interleave  (.avi)</td>
</tr>
<tr>
<td>Flash Video</td>
</tr>
<tr>
<td>MKV – Matroska</td>
</tr>
<tr>
<td>M2TS – MPEG Transport Stream (.m2ts)</td>
</tr>
<tr>
<td>MTS – MPEG Transport Steram (.ts, *.mts, *.m2t)</td>
</tr>
<tr>
<td>MPEG</td>
</tr>
<tr>
<td>MPEG-4</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>MPEG-4</td>
</tr>
<tr>
<td>OGV – Ogg Video</td>
</tr>
<tr>
<td>MOV – QuickTime</td>
</tr>
<tr>
<td>WebM</td>
</tr>
<tr>
<td>WMV – Windows Media Video</td>
</tr>
</tbody>
</table>
OpenGL troubleshooting

If you see the following message about OpenGL when you open Movavi Academic or you’ve noticed that the player, filters, or transitions do not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi Academic, your computer needs to support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

Your graphics card driver does not support the necessary OpenGL version. The program may fail to start or work incorrectly.

Click the link below to download and install the latest graphics card driver or see the full troubleshooting guide.
Download driver
Troubleshooting instructions

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:

Step 1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver installation file from the manufacturer’s website and install it following the on-screen instructions.
Detailed instructions on updating the driver

It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Academic. If you see an error message again, proceed to the next step.

Step 2: Try the software OpenGL implementation
If your graphics card still doesn’t support OpenGL 2.1 even after updating the driver, you can use a software alternative:

• In the message you see after starting Movavi Academic, select the Download and install software OpenGL implementation box.
• Or, in the main Movavi Academic window, open the Settings menu and choose Preferences. There, select the Use software OpenGL implementation option and click OK.
After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi Academic.

If these steps haven't helped:
• Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
• Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

Updating the graphics card driver
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance of applications and games on your computer.

Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution.
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type section. Note the full name of the graphics card somewhere for later.

Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that will automatically find the necessary driver.

NVIDIA download center
AMD download center
Intel download center

Warning:
Only download drivers from the official manufacturer's website. Third-party websites offering driver downloads may contain malware.

Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.

Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows you to optimize your computer's graphics performance.

1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please try the method above.

NVIDIA download center

2. In the Drivers section, click the Check for updates button to find the latest drivers.

3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and install the necessary driver for your system.
Updating AMD® or ATI® Driver

1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
   AMD Driver Download Center

2. Download the auto detect utility and run it when the download has finished.
   Auto Detect Utility

3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.

   If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and download the driver.

4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.

5. After the driver has been installed, it is recommended that you restart your computer.

If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.

If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have encountered. This will help our support team specialists solve your problem quicker.

---

**Glossary**

Here’s a list of some terms that you may come across while working with video and audio. You won’t need to know all of these to use Movavi software, but if you want to learn more about the specifics of media file processing, you can start here.

**Aspect ratio**

A video’s aspect ratio is the proportion of its width to height, e.g. 16:9 (read as sixteen-by-nine). Usually, you might encounter the 16:9 or 4:3 aspect ratios, but most recent displays and videos have the 16:9 aspect ratio. You might encounter 4:3 resolutions in some older TV videos.

Here's how different they look:

If you join videos with different aspect ratios, you might see black bars around the edges. Think of a video’s frame like a box: if you put a square peg into a rectangular hole, you might have room left over at the sides. This can happen in your project if you’re mixing videos and photos, or if you’re using videos from different sources. This is how it might look if you’re adding 4:3 videos to a 16:9 project and vice versa:

To remove the black bars, try using the **crop** tool, or change the **project settings**.

Learn more: [Removing black bars](#)
**Bitrate**

Bitrate is a property of digital video and audio files. It means the amount of data in bits contained in each second of the file. Higher bitrate allows to preserve more detail, but also requires much more disk space for the output file. Bitrate also depends on your video resolution, because you need much more data to store a large HD video frame compared to a tiny 360p video. If your video has lots of small details or fast action, you can choose a higher quality when saving the video. The output video will have a larger file size, but you’ll be able to see detail better.

**Codec**

Video and audio information is processed or encoded to shrink the size of the file. However, your computer needs to have a decoder installed in order to open the file. There are many different codecs, each compressing video in different ways. Many video formats can store multiple video formats. For example, you can save a video with the .mp4 extension, but you can use the H.264 or MPEG-4 codecs. If you don’t know what codec works best for you, go for H.264 – it is supported by most players and platforms. *Hint*: Don’t download codecs from suspicious websites. They may contain malware.

**Format**

Usually when someone mentions formats, they mean container formats, namely, the way of storing a video or audio file’s information inside a file. You can spot container formats by file extensions. A container format contains video and audio streams, that are be encoded with a codec. The figure below shows how a standard video file may look like.

![Video File Diagram](image)

**Frame rate, FPS**

A video’s frame rate is the number of frames or still images in each second of the video (also called FPS or frames per second). Most movies have a frame rate of 24 frames per second, but most cameras and mobile phones shoot video at 30 frames per second. More modern cameras even allow you to film with 60 FPS and above. If you have a higher frame rate, you can slow down the video to make a slow-motion effect without making the video look choppy.

**.mepx files**

Movavi Academic project files are saved with the MEPX extension. You can open the file in the Editor and continue working on your project.

**Resolution (frame size)**

A video’s resolution is basically its width and height in pixels. Usually it is written as the width multiplied by height, e.g. “1280x720”, or sometimes you might only see the height listed, e.g. “720p”. Usually, videos with high resolution have better quality because there are more pixels available for storing information. However, if you convert a low-quality video to a higher resolution, it will not instantly look better because there is nowhere to restore the extra information from, so you will end up with the same quality with a much larger file size. You can change the resolution of your output video in project settings.

**Sample rate**

The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.

**Stream**

A video file contains the video and audio information in separate streams, which simply means that their data is stored separately inside the file. When you play the file, these streams are played simultaneously, just like a stream of water.